ME 455/555 Intro to Finite Element Analysis Fall 2013 Abaqus/CAE Beam tutorial

Abaqus Beam Tutorial (ver. 6.12)

Problem Description

The two-dimensional bridge structure is simply supported at its lower corners. The structure is
composed of steel T-sections (E =210 GPa, v =0.25) oriented as shown below. A uniform distributed
load of 1000 N/m is applied to the lower horizontal members in the vertical downward direction.
Determine the stresses and the vertical displacements.
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Analysis Steps
1. Start Abaqus and choose to create a new model database
In the model tree double click on the “Parts” node (or right click on “parts” and select Create)

2.

3.

Model | Results

& Model Database E|

= fi§ Models (1)
= Model-1

L
lU@ Matiagals
E} Calibrations
ﬁ!',_[} Sections
E‘ Profiles

ﬁ Assembly

[ oll Steps (1)
B= Field Output Requests
% History Output Requests
Iﬂ Time Points
Bm ALE Adaptive Mesh Constraints
ﬁ Interactions
& Interaction Properties
gli Contact Controls
;1?’ Contact Initializations
ﬂ] Constraints
@ Connector Sections

F Fields
r\._; Amplitudes
% Loads
[% BCs
flm Predefined Fields
Remeshing Rules
I 4 Optimization Tasks
Y Sketches

T P —

»

m

-

g

In the Create Part dialog box (shown above)

a. name the part

Select “2D Planar”

Select “Deformable”
Select “Wire”

Set approximate size = 20
Click “Continue...”

=0 a0 o
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o Create Part 2

Mame: | Bridge
Maodeling Space
(7030 @ 2D Planar () Asisymmetric

Type Options
@ Deformable

() Discrete rigid

. ) . Mone available
() Analytical rigid

Basze Feature
1 Shell
@ Wire

1 Paint

Approximate size: | 20

Continue... Cancel
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4. Create the geometry shown below (not discussed here)

H |
T .
al 5_ . 5_ w
¥ f
5. Double click on the “Materials” node in the model tree
a. Name the new material and give it a description
b. Click on the “Mechanical” tab=»Elasticity=»Elastic
c. Define Young’s Modulus and Poisson’s Ratio (use Sl units)
WARNING: There are no predefined
systems of units within Abaqus, so the user | Model | Results
is responsible for ensuring that the correct | Model Database El - WG
values are specified
d. Click “OK” S48 Models (1) =
= Model-1
# s Parts (1)
Be
- E} Calibrations
B ﬁ:['; Sections
E‘ Profiles

&3] ﬂ Assembly

i+ ol Steps (1)

B2 Field Qutput Requests

- E}' History Output Requests

b= Time Points

- B;; ALE Adaptive Mesh Constraints

- "ﬁ-l_nt.e.@;ﬂm’;--\_ﬁm*_ﬂ P ST

m

©2013 Hormoz Zareh 3 Portland State University, Mechanical Engineering



ME 455/555 Intro to Finite Element Analysis

.
o Edit Material -‘ r

Fall 2013 Abaqus/CAE Beam tutorial

- ==

Mame:

Steel

Description:

Linear Isotropic Steel (Standard SI units) )

Material Behaviors
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e g ———

General | Mechanical Thermal Other \il

Plasticity
Damage for Ductile Metals

Damage for Traction Separation Laws

Damage for Fiber-Reinforced Composites

Damage for Elastomers

v

Hyperefastic
Hyperfoam
Low Density Foam

Hypoelastic

¥ ¥ vy rvr

Porous Elastic

Deformation Plasticity Viscoelastic

Damping

Expansion

Erittle Cracking

Eos

Viscosity

T P S SRR P S
{ &= Edit Material = |
1
1| Mame: | Steel |
Description: | Linear Isotropic Steel (Standard 51 units) 7

- A A e Bt W e P A b r’.f-—*-u-""‘-—r N

Material Behaviors

General Mechanical Thermal Other |

Elastic

Type: | Isotropic E“

Use terperature-dependent data

Mumber of field variables:
Moduli time scale (for viscoelasticity):

No compression
Mo tension
Data

Young's Poisson’s
Modulus Ratio

1 208 025
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6. Double click on the “Profiles” node in the model tree

Fall 2013

Abaqus/CAE Beam tutorial

a. Name the profile and select “T” for the shape
b. Note that the “T” shape is one of several predefined cross-sections
c. Click “Continue...”
d. Enter the values for the profile shown below
e. Click “OK”
= Create Profile L ® |
Model | Results | Material Library | Mame: | T-5ection
Model Database E| - Wy, g Shape
= 4§ Models (1) || | Bex
£ Model-1 Pipe
# flg Parts (1) Circular
Pz Materials (1) Rectangular
- E} Calibrations Hexagonal
) ﬁ!—._[.‘* Sections Trapezoidal
E‘ I
[+ ol Steps (1) :
) Arbitrary
-B= Field Output Requests 5 red
- EF History Output Requests EneraiEE
“b5 Time Points 3 -
- B ALE Adaptive Mesh Constraints Continue.. ] [ Cancel ]
ay, Jptatinn e, g, Pl ot —— i y,
2= Edit Profile % |
Mame: T-Section
Shape T
b: |0.25
42
h: |0.25
[ i
[ : ] [ 10125
_T_ l #: 0.05
t, HE T
f ! T : tw: | 0.05
t —u] —
W I
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7. Double click on the “Sections” node in the model tree

a.

EE Y]

™m0 o0 T

-,

Name the section “BeamProperties”

Select “Beam” for both the category and the type
Click “Continue...”

Leave the section integration set to “During Analysis”
Select the profile created above (T-Section)

Select the material created above (Steel)

Click “OK”

Model | Results | Material Library |
@ModelDatabase B : :’:ﬂ.“"ﬁ :Q:

Abaqus/CAE Beam tutorial

*
~,

Models (1)

= Model-1 o= Create Section

=2

5 [ Parts (1)
W [F2 Materials (1) Mame: | BeamProperties

- E} Calibrations Categor}r T]l"F"E

2] ﬁ Assembly
o Steps (1)
-B= Field Output Requests

i) Shell Truss

2 %:' History Output Requests e
I+ Time Points = e
2 E;p ALE Adaptive Mesh Constraints Other

-G Interactions

& Interaction Properties

=
i bt osw |

Cancel

4, Contact Contrgls

e T - b

=
2 Edit Beam Section [

Mame: BeamProperties

Type: Beam

Section integration:

Beam Shape
Profile name: | T-Section EI E’

Profile shape:

Basic | Stiffness | Fluid Inertia |
Material name: | Steel E| E

Section Poisson's ratio: |0

Temnperature variation:

() Before analysis

@ Linear by gradients

Interpolated from temperature points

ettt e n i e,
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8. Expand the “Parts” node in the model tree, expand the node of the part just created, and double click
on “Section Assignments”
a. Select the entire geometry in the viewport and press Enter
b. Select the section created above (BeamProperties)
c. Click “OK”

= Edit Section Assignment &J

Model | Resuts | Material Library |

] Model Database | -‘Q’-| Region
= 8 Models (1) - ] .
5 Model-1 B Region: (Picked)
=5 Parts (1)
5 Bridge Section
& Features (1)
b sets Section: | BearnProperties EI EE*
& Surfaces
@ Skins - - .
J stingers Note: List contains only sections
3} 3 applicable to the selected regions.
Ew Orientations * T , B
B Composite Layups yp= E=lw
?3 :‘g';:""gt;m“m’ Material: Steel
esh (Emp

[Pz Materials (1)

E} Calibrations
i?,- Sections (1)

pm B Drfiles (e nndte _,-——»-,,_f. L

9. Click on the “Assign Beam Orientation” icon
a. Select the entire geometry from the viewport
b. Click “Done” in the prompt area
c. Accept the default value of the approximate nl direction by pressing “Enter”
d. Click “OK”

Module: |5 Property EIJ'
e :
- 4

. ¥
&L ;
B
& nd y y
N :
Assign Beam 3
Crientation P

@ B f
o i

” y
i

s | ¥

]
»
-
-
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10. In the menu bar select View=>»Part Display Options
a. Check the Render beam profiles option on the General tab
b. Click “OK”

- B
# Part Display Cptions u
General | Datum | Mesh
| Render Style
) Wireframe () Hidden @ Shaded
Geometry
Show dotted lines in hidden render style
Show edges in shaded render style
i Show silhouette edges
[T] Highlight only visible entities
| Face highlighting: | Stippling E|
| |
|| Curve refinement:
S —— I MNote: The refinement setting will be applied only
L Edw O REnpOE m i to the current part.
ewport | View Seed Mesh Adaptivity Featg: | [C] Show reference representation
Lo S Apply translucency
Pan ) - PRy TransTieens
-
Rotate F3 | Mesh
Zoom In/Out F4  [dule |~:- Mz i
Box Zoom £S5 — | Show: | BExterior edges E|
Auto-fit B L E:i, { Show edges in shaded render style
Cycle Views F7 k ; s . .
: A [C] Highlight only visible entities
Specify... & }
Parallel ; Always show substructure with translucency
Perspective % . ! -
atures (1! R A ] s N Idealizations
s e = * 2 Render beam profiles
Riaces Toolbars b= v | ‘ g
ins View Options... 5 ; Scale facton
- . S
‘ingers Graphics Options... s ¢ ||| £ Render shell thickness
iction Ass Light Options... s B } o o
ientation  Image/Movie Options... JO Scale factor |:|
smposite Part Qisplaygptions... — | ¢
. . ! q -
:gineering Features ‘ W, 9=, } [ 0K ] [ Apply ] [ Defaults l [ Cancel
MW~A;’---%&¢.-- — e e —
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11. Note that the preview shows that the beam cross sections are not all orientated as desired (see
Problem Description)

A

a. Inthe toolbox area click on the “Assign Beam/Truss ™
Tangent” icon B [Ny N

b. Select the sections of the geometry that are off by 180 1@, ' o ——
L ss1gn beamy I russ

degrees Tangent
c. Click “Done” @ =l

e B W R

|
‘s
|

Module: |E Property El Model: |: Model-1 El Part: |: Bridge El
2
x
EL
L8

|E| Select the edges whose tangents are to be flipped

e T T P I R  TI F R TSR P Uy s PPy
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12. Expand the “Assembly” node in the model tree and then double click on “Instances”
a. Select “Dependent” for the instance type
b. Click “OK”

Model | Results | Material Library |
- =
i e == Create Instance ﬁ

gMndelDatabase H - n@h & b

E#F Models (1) Parts

) Model] Bridge |
H 5 Parts (1)

P2 Materials (1)

- &% Calibrations

B 9% Sections (2)

@' Profiles

=] ﬁ Assembly
[ Instance Type

»

- fiZ Positionlsbnstraints
- & Features

b Sets

M Surfaces Mote: To change a Dependent instance's
AB Connector Assignments mesh, you must edit its part's mesh.
47 Engineering Features
[+ b Steps (1)

- Bz Field Output Requests

e o History Output Requests . L.,

m

@ Dependent (mesh on part);

) Independent (mesh on instance)

[7] Auto-offset from other instances

[ 0K J l Apply ] [ Cancel ]

13. Double click on the “Steps” node in the model tree
a. Name the step, set the procedure to “Genera
b. Select “Static, General”
c. Click “Continue...”
d. Give the step a description
e. Click “OK”

Ill
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-
o5 Create Step

===

Name: Load

Model | Results

£ Model Database

=4 Models (1)

& Model-1

s Parts (1)

@ [E2 Materials (1)
- E} Calibrations

Insert new step after

‘IEEE

. h Time Points
- Bm ALE Adaptive Mesh Constraints
-G Interactions

& Interaction Properties
i e te L Sl

m

Static, Riks

PRI

[E:] ﬁr_f} Sections (2) Procedure type: | General E|
@ Profiles Dynamic, Explicit
& ﬁ Assembly Dynamic, Temp-disp, Explicit
ol Geostatic
- B= Field Ouayut Requests Heat transfer
- B History Output Requests znalss diffusion
oils

Static, General

mn

4= Edit Step

MName: Load

Type: Static, General

Basic | Incrementation | Other |

Description: | Apply distributed load to lower members

Tirme period: |1

(This setting controls the inclusion of nonlinear effects

Nigeom: ) on oflarge displacements and affects subsequent steps.)

Automatic stabilization: | None EI

[[]Include adiabatic heating effects

PPVl e ST R S TR

P T T

14. Expand the Field Output Requests node in the model tree, and then double click on F-Output-1 (F-

Output-1 was automatically generated when creating the
step)
a. Asthey are not needed for the current analysis,
uncheck the variables “Strains” and “Contact”
b. To view results for beam stress, and shear and
moment diagrams open “Forces/Reactions”
c. Click “Section Forces and Moments”
Click “OK”
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Model | Results

Moedel Database

B 5 Models (1)

E Medel-1

5 Parts (1)

B [F2 Materials (1)

- E} Calibrations

B i& Sections (2)

@’ Profiles

&3] ﬂ Assembly

=lofh Steps (2)

@ o Initial

=8 Load

= % Field Qutput Requests (1)
&3] % Histery Otput Requests (1)
- l“j Time Points

E;p ALE Adaptive Mesh Constraints
-G Interacticns

E Interaction Properties

H: 0w @

»

m

—— e par== L ]

—_

- antact Controls
- Contact Controls _,
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E N
- Edit Field Output Request [

Name:  F-Output-1
Step: Load

Procedure: Static, General

Domain: Whole medel H
Frequency: | Every n increments ol
Timing: | Qutput at exact times
Qutput Variables
(@ Select from list below () Preselected defaults (0 All () Edit variables
5.URF,CF
P [ Stresses =
» [C] Strains
} @ Displacement/Velocity/Acceleration
P [ Forces/Reactions
| v D :
»
»
»

m

[ Energy
[ Failure/Fracture

["] Thermal i
M |« T ] +

Note: Some error indicators are not available when Domain is Whole Model or Interacti
[C] Output for rebar
Qutput at shell, beam, and layered section points:

@ Use defaults () Specify:

\ Include local coordinate directions when available

UL Vs

@ Select from list below () Preselected defaults () All () Edit variables
CDISP,CF,CSTRESS, LE, PE,PEEQ, PEMAG,RF,5,5F, U,
T o &Jﬁ Assembly
B [ Displacement/Velocity/Acceleration | 1 ol Steps (2)
w [l Forces/Reactions | B= Feld Output Requests (1)
RF, Reaction forces and moments I = % History Qutput Requests (1)
[C] RT, Reaction forces L o =
[] RM, Reaction moments . Switch Context Ctrl+5pace
}ﬂ Timel
CF, Concentrated forces and moments =
B;F ALE A Edit...
%SFr Section forces and moments c
'TF, Total forces and moments - ﬁ Interac ORY-
[] WF, Viscous forces and moments due to static stabilization E Intera Rename...
, Effective axial force for beams and pipes subjected to pressure lo - onta
[] ESF1, Effecti ial fi forb d pip bjected to p | Cont
[7] MFORC, Modal forces due to element stresses i - ;]?" Conta Suppress
] 1 F
[ | €] Const Resume
Note: S indicat t available when Domain is Whole Model or Interacti N
lote: Some error indicators are not available when Demain is Whele Model or Interacti @ Conne Set A= Root
[] Qutput for rebar @ F Fields Expand All Under
o el rﬂ-— P I B . T R 4 - =
— e e B . Pb Ampli Collapse All Under in
<[ Loads
[ BCs

e T PN |

15. Expand the History Output Requests node in the model tree
a. Right click on H-Output-1 (H-Output-1 was automatically generated when creating the step)
b. Select Delete
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16. Double click on the “BCs” node in the model tree
a. Name the boundary conditioned “Pinned” and select “Displacement/Rotation” for the type
Click “Continue...”
Select the lower-left vertex of the geometry and press “Done” in the prompt area
Check the U1 and U2 displacements and set them to 0
Click “OK”
Repeat for the lower-right vertex, but model a roller restraint (only U2 fixed) instead

o

r B
a= Create Boundary Condition ﬁ

Mame: | Pinned

e - Step: | Load EI
E Interaction Properties
ﬂii Contact Centrols

- ;ﬁ' Contact Initializations Category Types for Selected Step

-] Constraints @ Mechanical | Symmetry/Antisymmetry/Encastre
@ Connector Sections Fluic
®F Fields- © Other Velocity/Angular velocity

Py Amplitudes Connector displacement

E Loads Connector velocity

[z Prewsfined Fields
-- Remeshing Rules
[ Optimizaticn Tasks
-1 Sketches

A Annotations

....-.I%J.PEL-—-‘ PSP 'r"—""—-—-f_’“ aa L

Procedure: Static, General

m

2 Edit Boundary Condition

Mame: Pinned

Type:  Displacernent/Rotation
Step: Load (Static, General)
Region: (Picked)

C5Y5: (Global) k Ao

Distribution: | Uniform EI fix)
U1 0

Uz 0

[ UR3: radians

Amplitude: | (Ramp) EI Pb’

MNote: The displacement value will be
maintained in subsequent steps.
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17. Double click on the “Loads” node in the model tree

a. Name the load “Distributed load” and select “Line load” as the type

b. Click “Continue...”

c. Select the lower horizontal edges of the geometry press “Done” in the prompt area

d. Specify component2 =-1000 *Note that because we have been using standard Sl units the
load applied is -1000 N/m, which is a total of -10,000 N distributed across the lower horizontal
members

e. Click “OK”

- ki
2 Create Load M

-4 Contact Initializations Hagsel Distiabuted | oad
“ﬂ] Constraints Step: | Load E|
@ Connector Sections Procedure: Static, General
Ed T Fields E Category Types for Selected Step
Pka Amplitudes @ Mechanical Concentrated force o
- ﬂ;‘h Therma Morment
[ b BCs Acoustic Pressure
[l Predefined Fields Fluid ohell edge fozd |
£ . ) Surface traction
-- Rermeshing Rules () Electrical Pipe pressure 1
- Optimization Tasks ass diffusion || | Body force
T Seetches s
-~ Annotations Gravity
i Balt load -
I':'I$$ Analysis
Igl lobs Continue Cancel
IR OPOUSE .| [ Continge.. | [ Cancel |
© N
& Edit Load | =

Mame: Distributed_Load
Type:  Line load

Step: Load (5tatic, General)
Region: (Picked)

Systerm: Global EI
Distribution: | Uniform EI fix)
Component 1:

Component 2: | -1000

Amplitude: (Ramp) EI PU
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L.

18. In the model tree double click on “Mesh” for the Bridge part

a. Inthe toolbox area click on the “Assign Element Type” icon

Select “Standard” for element type
Select “Linear” for geometric order
Select “Beam” for family

o

controls
g. Click “OK”

[ ﬁ Models (1)
= Model-1
Efls Parts (1)
= Bridge
i Features (1)
b Sets
W Surfaces
$ Skins
ﬂ Stringers
ﬂ:r,'« Section Assignments (1)
Fe Orientations
B Composite Layups
& 47 Engineering Features
s Mesh (Emfg]
|22 Materials (1)
E} Calibrations

ﬁr_r} Sections (1)
P T Y
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m

= gt g

Highlight all members in the viewport and select Done

Note that the name of the element (B21) and its description are given below the element

Maodule: |5 Mesh : Mod?

L4

i
?i% .

#4 F \
=* f
E Assign Tl
Element Type i
a, ‘
5 b, |
i o
¥ ;
"tt-,.__‘}___‘ P — ___,..-fr

L3
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r - . e -
# Element Type u

Element Library Farnily
Acoustic -
Geometric Order Coupled Temperature-Displacement
@ Linear ) Quadratic Gasket -

I Line

| [T] Hybrid formulation

Element Controls

Beam type: @ Shear-flexible () Cubic formulation

i
Scaling factors: Linear bulk viscosi :u
| ty: .

I B21: A 2-node linear beam in a plane.

Note: To select an element shape for meshing,
select "Mesh->Controls” frem the main menu bar.

19. In the toolbox area click on the “Seed Edges” icon
a. Select the entire geometry, except the lower horizontal lines
b. Click “Done” in the prompt area

Module: EMesh i Mo?

Ty [ L %
i =
d

Seed Edges

T b g ek e bR e o e e

i
ag = . = SNSRI

Lo Select the regions to be assigned local seeds | individually

|Dune| [C] Use single-bias picking

EN
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i N
= Local Seeds ﬁ
Basic | Constraints

c. Choose “By Number” Method and set the Method Bias
number of elements along the edges as 5 ©) By size @ None © Single ) Double
(under Sizing Controls) @ By number
d. Repeat for the lower horizontal lines,
. Sizing Controls
except specify 10 elements along the
Mumber of elements: 55
edges

Set Creation

[T] Create set with name: | Edge Seeds-1

[ QK ] [ Apply ] [Defaults] [ Cancel ]

20. In the toolbox area click on the “Mesh Part” icon
Click “Yes” in the prompt area

Module: |5 Mesh : Modf

| Bl ;
b )
qush F'art] :
EK f.
& :
Fa, {
0 -+ ':
Ir—1‘ ﬂ“—! ; = OK to mesh the part? [ﬁ
A e e Y
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21. In the model tree double click on the “Job” node

a.

b
C.
d

©2013 Hormoz Zareh

Name the job “Bridge”
Click “Continue...”

Give the job a description
Click “OK”

r# Create Job | 2 |1

Mame: |Bridge |

‘“M'ﬁtsmv\-"ﬂ\ha-ﬂ\,_-"h\'“m Source: | Model H
[ Predefined Fields T

Remeshing Rules
’u! Optimization Tasks
]b Sketches

-~ Annotations

Eltg Analysis

',. Adaprivity Processes

M Co-executions I Continue.., I [ Cancel ]
o 4 Optimization Processes

4

& Edit Job [ = ]

Name: Bridge
Model: Model-1

Analysis product:  Abaqus/Standard

Description: |Static analysis of a bridge with a distributed load

Submission | General | Memory | Parallelization | Precision

Job Type
@ Full analysis

() Recover (Explicit)

() Restart
Run Mode
N N Host name:
@ Background () Queue:
Type:
Submit Time

@ Immediately
.".'eit:|:|hrs.|:|min.

Conc
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22. In the model tree right click on the job just created (Bridge) and select “Submit”
While Abaqus is solving the problem right click on the job submitted (Bridge), and select “Monitor”
a. Inthe Monitor window check that there are no errors or warnings
b. If there are errors, investigate the cause(s) before resolving
c. Ifthere are warnings, determine if the warnings are relevant, some warnings can be safely

ignored
“Hg Amplitudes 1
I Loads (1) b wim cvaus
|-\.4- = ! H - -~
I Switch Context Ctrl+5pace i i :“ Switch Context Ctrl+Space o
1
Edit... b e | Edit...
Copy... { f
opy 4 'y Copy... ;
Rename... : I& ‘ Rename...
Delete... Del f f Annot:  Delete.. Del 1
i Write Input g a§§ Analys  Write Input ;
Data Check . =] = Data Check i
(O (s ]
-Gl Ad:  Continue : :  Continue ;
1 % Ad:_ Confinue 7
Bean Results ass Bean Results ass
Appl K 79 Appl K 79
45 = ated | 45 = ted:
[l LThe Export - armeatd [lThe o cEwor L b freatd

[ ™
2= Bridge Monitor @M
Job: Bridge Status: Completed

Severe = 2
3 Equil Total Total Step Time/LPF
Stepiljjicren A Discon fter Iter  Time/ffreq  Time/LPF Inc
1 1 1 0 1 1 1 1 1

Log | Errors | Warnings | Output | Data File | Message File | Status File

»

Completed: Abaqus/Standard

A

Completed: Wed Oct 05 17:05:08 2011

Search Text
Text to find: || [ Match case [l Mext 1} Previous

Dismiss
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23. In the model tree right click on the submitted and o pass j
[ Loads (1) 1
successfully completed job (Bridge), and select “Results” Bl BCs Switch Context Ctrl+ Space :
Edit... 3
Copy... ;
Rename... F
A Annotatio Delete... Del 1
SEE Analysis Write Input 1:
=2 | Data Check !
| Submit _’r
lﬁﬂ Adapth  Continue I
’M Co-exe Monitor...
[ — [The joi 1
Job Br: Kill - e
(30 i o # o . AP
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24. In the menu bar click on Viewport=>»Viewport Annotations Options
a. Uncheck the “Show compass option”

b. The locations of viewport items can be specified on the corresponding tab in the Viewport

Annotations Options

c. Click “OK”

Student Edition 6:11-2 [Viewport: 1N IR

el | Viewport View Result Plot
- Create
09—

C;!gcade

@

Tile Horizontally
Tile Vertically

2ta  Delete Current

15(

Annotation Manager...
Create Annotation...
Edit Annotations...

Qi

Animate

Viewport Annotation Options... i
0 -
" Linked Viewports... b 2

v 1Viewport:1 OQDB: C:/Temp/Truss.odb

Rep

=TT

k

Aottt aant . s sttt -J”*.—'"‘

25.

Sl <Al

H_ LT TN P S VT gy PRy |

F
s Viewport Annotation Options

EEX)

General | Triad | Legend | itleBlock | State Block

Visibility

Show triad
Show legend

[] Show title black
Show state block

Show text and arrows

[ ok | [ Apply | [ Defoults | [ Cancel |

a. Click on the icon for “Plot Contours on Deformed Shape”
b. Click on the icon for “Allow Multiple Plot States”
c. Click on the icon for “Plot Undeformed Shape”

ARE % ;
=g;;g ¥
_— 1
k|

BE&|
.. *

o e 7
Plot Contours on |
Deformed Shape | 4
T E ;
:I‘%| !“E 1
a == {

1

255
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Display the deformed contour of the (Von) Mises stress overlaid with the undeformed geometry



ME 455/555 Intro to Finite Element Analysis
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26. In the toolbox area click on the “Common Plot Options” icon
Note that the Deformation Scale Factor can be set on the “Basic” tab
b. On the “Labels” tab check the show node symbols icon
Click “OK”

a.

C.

©2013 Hormoz Zareh

Basic | Color & Style | Labels | MNormals | Other |
Render Style Visible Edges
€ *) Hidden ) All edges
() Filled @ Shaded @ Bxterior edges
Deformation Scale Factor () Feature edges
—_ — () Free edges
Module: |5 Visualization EI ? @ Auto-compute (3307.11) & No ed
) Uniform () Monunifarm oe.ges
AHE E@ 4 o
(g N 1
A . p
| Common Gptlons| ‘!
LS *‘
¥
mnJI.I. !
&, B d
5 .. ¥
B y,
o F [ ok | [ Apply | | Defaults | | Cancel
B, O | L et |
r
¢ Common Plot Options E

Abaqus/CAE Beam tutorial

-
a¢ Common Plot Options

=)

| Basic | Color&Ster| Labels | MNormals | Other |

Labels and Symbols

|Set Font for All Model Labels...|

Color Code

Show element labels  Colon [:]
[ Show face labels Color: [N
Show node labels Color; (mE
Show node symbols  Color: (]

Symbol: | W E| Size:  Small E|

Allow color code selections to override
options in this dialog

Probe Annotations

Color; (I

[ ok |

[ Apply ] [Defaulis] [ Cancel ]
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S, Mises

fraction=-1.111111

(Avg: 75%)
+2.66532+06
+2.4452+06
+2.225e+06
+2.006e+06
+1.786e+06
+1.5672+06
+1.347e+06
+1.127e+06
+9.077e+05
+6.280=+05
+4.6842+05
+2.487e+05
+2.90%=+04

e . ¢ .

h » - L |

&
» o ° * e e
— % Step: Load, Apply distributed load to lower members
Increment 1: Step Time = 1.000
Primary Var: S, Mises
Deformed war: U Deformation Scale Factor: +9.034e+03

27. To determine the stress values, Click the “Probe Values” icon
a. Check the boxes labeled “Nodes” and “S, Mises”
b. Inthe viewport mouse over the element of interest
Note that Abaqus reports stress values from the integration points, which may differ slightly from the
values determined by projecting values from the surrounding integration points to the nodes
The minimum and maximum stress values contained in the legend are from the stresses projected to
the nodes
c. Click on an element to store it in the “Selected Probe Values” portion of the dialogue box
d. Click “Cancel”
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™
5 Probe Values =
Field Output...
ofa Step: 1, Load Frame: 1
% Field output variable for Probe: S, Mises (Avg: 75%)
T e Probe Values
i 1 @ Select from viewport (0 Key-in label () Select a display group
- i
; Probe: | Modes El Components: | Selected E|
H{“' j Value for Attached elements:
Q v 2 [T Partlnstance NodelID Orig.Coords Def.Coords Attached elements S, Mises
sl ] BRIDGE-1 35 1.90382e+06
B o * [C]  BRIDGE-1 5 807574
4
‘i A -+
i z x
\ !
I | | Note: Click on respective check button to annotate values in viewer
P
1
el Data Chlse
28. Change the output being displayed _ . .
J P § display Jiewport  View Result  Plot  Animate Report  Og

a. Change the display option in the tool
bar to “U”
b. Select component “U2”

11040

c. Again nodal displacements can be

ﬂ-?i Prirnary EI U

found using the “Probe Values” tool

29. To investigate stresses through the beam section
a. Click on the “ODB display options” icon
b. Select “Display Beam Profiles”

5, Mises ¢
fraction = -14
(Avg: 75%) 4

c. Click “OK”

Odb Display Options [ 665§
isplay Opticns e
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Fall 2013

Abaqus/CAE Beam tutorial

o —
4= ODB Display Options ' -

=

General | Entity Display | Constraints | Sweep/Extrude | Mirror/Pattern

Curved Lines & Faces

Refinement level: | Coarse E|

Elements with Mo Results

Coler: [

Feature Angle

20
=1

(Used when Visible Edges = Feature edges)
Idealizations
Render beam profiles

Scalefactor: |1

[7] Render shell thickness

L

cale factor: [l

Model Change
Account for deactivated elements

| ok | | Apply | | Defaults |

[ Cancel ] y
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30. Change the output displayed to “Beam Stress” s Primary H BEAM STF-'.EE 11 HB
a. Select the appropriate component, for 3 AC VIELD ¥
b
example S11 !
b. The display will show the stress distribution CF Module: | Vis
across the beam section. *Note: these values H {CM3 b2 o
. . 1 E 14 @ ’
cannot be queried, but the resolution of the M bE = L
. . i B
color display can be increased to more clearly PEEQ = :
highlight the location of the neutral axis. PEMAG - Eﬁ‘; !
i
RF | 5
RM3 Q L
i k) K
' 5 b P
o L@ Bl |{
H i
! Qo 1
S f, Qe r.
U B k|3
UR3 . {
el e o FE dmu_h-

31. To adjust the display plot contours
a. Inthe menu bar, select Options -> Contour
b. Adjust the resolution
c. Click “OK”

.
# Contour Plot Options

Color & Style | Limits | Other |

-

Report 'gptions Tools Plug-ins ﬂelpi.

IS

Common...

Superimpose...

Contour Type
(71 Line @ Banded ) Quilt ) Isosurface

[7] Show tick marks for line elements

Contour Intervals
() Continuous
- 12

i@ Discrete I

s 2 Vi Symbol... Emp/Brit :
= |E Vis, 2 emp/Bri Interval type: | Uniform

Material Orientation... —;’ EI
%.1 B XY Options > ; e
33::: Ply Stack Plot... ¢ Contour Method
— Animation... ? _ ]

. } @ Texture-mapped () Tessellated

- View Cut... p L
b Eree Body... i Cl
fe Stream... 3
& Display Body... pt
| | BT ] M | ok | | Apply | | Defauits | | Cancel |
Laem | AALRH D6 - s armaa?
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32. To see beam shear and moment diagrams
a. Change to plot “Plot Contours on Undeformed Shape”
b. Turn off “Render Beam Profiles” under ODB display options
c. Adjust the view to be square to the part plane using the “Apply Front View” icon

- \
4% QDB Display Options - . - =

General | Entity Display | Constraints | Sweep/Extrude | Mirror/Pattern

Curved Lines 8 Faces

Refinernent level: | Coarse E|

12|z E@ i |
Lo?1a e Elements with No Results
=E::: ; Color: [:]

a- J, Feature Angle

20

; i " |

% (Used when Visible Edges = Feature edges)
plom i

ase 3

Idealizations

Render beam profiles
L

| Plot Undeformed
| Shape Scale factor: |1 urt  Options Tools Plug-ins  Help K? |

{
f :
Iﬂ% HE:: 1 [T Render shell thickness :| (. o€ L_l'k |E| Tl g g ?
B J
{
4
H

1
a

Y ... Model Change !Y ”,: }j m Ef EE Ej zi‘ 1 :‘T

11 g Account for deactivated elements

=5

B e I P,

Apply !

Yisualization o C:/Temp/Bridge.odb D

Front View

[ 0K ] [ Apply ] [Defau\ts] [ Cancel ]

L T —

et N

d. Choose the appropriate display output
i. For moment values choose “SM, component SM1”
ii. For shear force values choose “SF, component SF1”

awport View  Result  Plot  Animate F‘.gpcurtj
L primary [+ sm MED! E|[__~.§
-

e bR =, e o
e. Asthe default display is not very useful for line type element, change to a “Bending-Moment”
type plot under contour options
i. Select Options -> Contour
ii. Click “Show tick marks for line elements”
iii. *Note- the display group has been reduced for clarity
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i B
# Contour Plot Options g

Color & Style | Limits | Other |

Contour Type
() Line @ Banded ) Quilt ) Isosurface

[] Show tick marks for line elements

Report 'gptions Tools Plug-ins _tl_elp:.

EJ@ Common... 1 : Contour Intervals
Superimpose... ") Continuous 1
i@ Discrete I 1

Symbol... =mp/Bri, Interval type: | Uni
) pe: | Uniform
Material Orientation... 4 EI

ﬁ [ XY Options 3

L

Ply Stack Plot...
Animation...
View Cut...
Eree Body...
Stream...

3 Display Body...

-I.070e+U6
" - -l m parts ar./

Contour Method

@ Texture-mapped () Tessellated

.‘[;)'.

e S e T L S s Wt bk

| ok | | Apply | | Defauits | | Cancel |

S, 5M1

(Awg: 75%)
+1.346e+03
+1.124e+03
+9.020e+0%2
+6.798e+02
+4.576e+02
+2.354e+02
+1.318e+01
-2.090e+02
-4.312e+02
-6.534e+02
-8.756e+02
-1.098e+03
-1.320e+03

¥
t x Step: Load, apply distributed load to lower members
B=b X I crement 1: Step Time = 1.000

Primary War: SM, SM1
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Beam stress:

Select the “Beam stress” from the main toolbar. Primary E| U El u2 E|
ACYIELD

If interested in the bending stress, select S11 as the stress
component. Primary EIEEAM_STF‘.EH Miises

The example below shows the bending stress distribution across
a wide-flange beam.

kdn

BE&M_STRESS, S11

(Avg: 75%)
+1.208e+07
+1.005e+07
+2.030e+06
+6.006e+06
+3.983e+06
+1.960e+06
-6.325e+04
-2.086e+06
-4.110e+06
-6.133e+06
-8.156e+06
-1.018e+07
-1.220e+07
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